Net Probe

Net Probe is a site list maintenance utility. It can import ftp and web sites from numerous sources including text, HTML, FTP Voyager files and
the clipboard. It can then check the sites to see if they are alive and if they have been updated. You no longer have to spend hours keeping track
of whether your favorite sites on the Internet are up or down or if anything is new; Net Probe can check them all for you in about the time it
would take you to check one. It can also download the content of each web page on your list. You can even schedule Net Probe to check your
site list periodically. It is multithreaded, easy to use, and cooperates nicely with your favorite ftp client or web browser.

Net Probe is shareware and must be registered after your evaluation period if you decide to use it. Registration entitles you to 1 year's support
via e-mail and notification of future upgrades. Registration also bypasses those annoying "splash" and "nag" dialog boxes. For more
information click here.

Some topics covered by this help file are:

Registering Net Probe
Technical Support
Contacting Rhino Software
Site Profile Dialog
ETP Search Dialog
Options Dialog
General Options
Connection Options

Logging Options
The Toolbar

Menus
File Menu
Edit Menu
View Menu
Tools Menu

Help Menu

Pop-Up Menu
Customize Toolbar

Rhino Software
P.O. Box 53
Helenville, WI 53137

Phone: (414) 593-2753

FAX: (414) 593-2753
http://www.rhinosoft.com
mailto:sales@rhinosoft.com
mailto:support@rhinosoft.com



Registering Net Probe

Registration of Net Probe is essential to providing you, our customer, with quality inexpensive software. If you use Net Probe please register.

To register your copy of Net Probe and receive your registration number, press "Purchase" in the "Purchase Dialog" or mail your payment, name,
address, and e-mail address to:

Rhino Software
P.O. Box 53
Helenville, WI 53137

Single: $24.95

2-9: $22.95 each
10-24: $19.95 each
25-49: $17.95 each
50-99: $14.95 each
100-199: $12.95 each
200+: Call

Site Licenses: Available

Wisconsin Residents, add 5.6% sales tax.

You may also FAX your order to (414) 593-2753. Use the form found at:
http://www.rhinosoft.com/RhinoSoft/NetProbeOrder.htm

Rhino Software can be reached at:
(414) 593-2753 -and- sales@rhinosoft.com

Please remember to include your name and e-mail address so we can send your registration ID. We will e-mail your ID within 48 hours.

More information about Rhino Software and Net Probe can be found at http://www.rhinosoft.com



Technical Support

Registered users are able to contact technical support via e-mail. Technical support issues are usually handled through e-mail only. We do,
however provide technical support by voice when required, but only to registered users.

If you need technical support, write to:
support@rhinosoft.com

We will help you via e-mail as soon as possible. This service is only available to registered users.



Contacting Rhino Software

You may contact Rhino Software by snail-mail at:
Rhino Software

P.O. Box 53

Helenville, WI 53137

Phone: (414) 593-2753
FAX: (414) 593-2753

For sales inquiries:
mailto:sales@rhinosoft.com

You may also find what you need at our web site:
http://www.rhinosoft.com

Click here for information about technical support.



Toolbar

The Net Probe tool bar allows you to perform many of the common Net Probe commands quickly by pressing a button.

New
This command creates a new site list. If a site list is already open and has not been saved since last it was changed, you will be asked if you
would like to save the old list before creating a new one.
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Open
se this command to open a previously saved site list.
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Save
0 save the current site list, use this command.
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Cut
f you have any sites selected, they will be copied into the clipboard in text format and deleted from the current site list. If you paste these sites
ack into Net Probe, you will lose the site's status, description, and time last checked.
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Copy
his command has the same effect as the Cut command, except that the selected sites are not deleted from the site list.
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Paste
If there are any sites currently in the clipboard, they will be imported into the current site list as if you had used the Import command to import
them as text.

]

Import

To read sites in from text files, HTML files or FTP Voyager files use this command. Net Probe uses regular expressions to parse the text that is
imported, and can accommodate a variety of formats. The most common format that Net Probe can read is a URL, such as
http://www.rhinosoft.com:80/RhinoSoft/index.htm, while specifying login and password using l: login p: password. This button is disabled by
default
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Export
0 write sites to text files. This button is disabled by default.
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New Site
ialog will appear which allows you to specify the site's name, description, and other properties. After completing the necessary information,
site will be added to the list.
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Edit Site
his button brings up the same dialog that was used to add a site and lets you edit a site's properties.
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Delete Selected
he delete command allows you to remove sites from the site list.
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Check All

This command allows you to check all sites on the list. Sites that have changed since last time they were checked (or sites that have never been
checked) will have a light bulb in their name field. Sites that have not changed, but which are up, will show a green check. Sites that are bad
will have a red X, and sites that have never been checked will have a question mark near them.

Check Selected

This command allows you to check the selected site. Sites that have changed since last time they were checked (or sites that have never been
checked) will have a light bulb in their name field. Sites that have not changed, but which are up, will show a green check. Sites that are bad
will have a red X, and sites that have never been checked will have a question mark near them.
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Open Site
Open site allows you to launch your default web browser to the selected web site, or your preferred FTP client to the selected FTP site. You may
change your FTP client in the General Options.
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FTP Search
This command brings up a dialog that allows you to search the Internet for a particular file.

About
Use this command to display the version number of Net Probe. If you are using a registered version of Net Probe, your name will appear in this
dialog box.



Site Profile Dialog

This dialog allows you to configure an individual site.

Name

Enter a name you want to use to remember the site. For example, you might enter "Rhino Software" to identify
"www.rhinosoft.com/pub/rhinosoft". Choose a name that is unique to the folder and choose a name that helps you identify the site. A site name
is a required field.

Description

Enter a description of the site that will give you additional information to help you identify what the site contains. For example, for the Rhino
Software site, you might enter "Rhino Software FTP site. Home of FTP Voyager." The description is used only for information and is not
required.

Site

Enter the Site address. The site address is used to identify the site to which you want to connect. Valid Site addresses may be textual
(www.rhinosoft.com) or they may be IP addresses (156.46.1.179). The Site is a required field. You cannot connect to a Site without entering a
Site address.

Default Directory
Enter the directory or folder you want to start in on the remote machine.

Anonymous Login
Selecting Anonymous Login allows you to access an FTP site without specifying a User ID or Password. The default Anonymous User ID and
Password will be used to connect to this site. If checked, User ID, Password are unavailable.

User ID
Enter your user ID required for logging into an FTP site. This field is not available when Anonymous Login is selected.

Password
Enter your password required for logging into an FTP site. This field is not available when Anonymous Login is selected.

Port
This is the port that will be connected to on the remote host. This will generally be port 21 for FTP and port 80 for HTTP.

Use HTTP
Check this box if you are trying to add a web site instead of an FTP site.



FTP Search Dialog

This dialog allows you to search the Internet for a particular file.

File
This string will be used to match the filename. Depending on the Search type selected, this may be the exact filename, a fragment of a filename,
or a regular expression.

Search Type
If you only know a part of the filename you are searching for, use 'Substring'. If you have the exact filename you are looking for, use 'Exact’. If
you would like to use a Regular expression, click that box.

Case sensitive
This is an option that allows you to specify whether you want 'file.zip' to match with 'File.zip' or not.

Try exact match first
If doing a substring or regexp search, an exact search will be done first.

Max matches
The maximum number of entries to be returned.



Options
The options dialog allows you to setup options of Net Probe. The Options Dialog is divided into several pages:
General Options

These options contain general type options used to configure Net Probe, the options found here include the scheduler parameters and the ability to
specify a FTP client.

Connection Options
These options contain information used to connect to FTP Sites. The information found here includes Proxy Server, Port Number, and various

timeout values

Logging Options
These options allow you to automate tedious tasks such as exporting lists and downloading web content.



General Options

The following are the General Options available in the Options Dialog:

Check Sites
This list box allows you to choose how often you would like Net Probe to check your sites for you.

Confirm Delete
Allows you to specify whether you would like Net Probe to ask for confirmation before deleting sites.

Open last file
Select this option if you want Net Probe to automatically open the most recent site list when it starts.

Anonymous User ID

Use this field to specify what you would like Net Probe to use as a user ID if none is found when importing or creating new sites.
Anonymous Password

Use this field to specify what you would like Net Probe to use as a password if none is found when importing or creating new sites.

Launch FTP Voyager
If this option is selected, Net Probe will attempt to locate FTP Voyager on your system and use it when opening FTP sites.

Launch another FTP Client
Use this option if you would like to use an FTP client besides FTP Voyager. You must specify a command line to launch your FTP client. Use
the following substitutions:

%0 = port
%u = user
%p = pass
%t = path
%h = host

Customize Toolbar
The toolbar options allow you to choose which toolbar buttons you want to use. A dialog appears allowing you to remove items from the right
side, and add buttons from the left side. You may also move button positions by selecting move up and move down.

For more information about customizing your tool bar, click here. For other Toolbar Customization methods, click here.

Select columns to view
This allows you to select which columns you wish to appear in the list view.

List Options
The List options allow you to customize the right-hand pane or "List" view of Net Probe. The right hand pane shows you files and folders for
the selected folder in the left-hand pane or "Tree" view. The following are the options:

Gridlines
This option allows you to place grid lines or dividers between all items in the pane. When selected, faint or gray, lines appear between all of the
files and folders. This option is only supported in Details view.

Track Select

This option moves a "tracker" or changes the color of the selection beneath the mouse when the mouse pointer moves over the top of a file or
folder. The item beneath the mouse turns a different color. If you hold the mouse over the selection without clicking on it, the item becomes
selected.

Header Drag and Drop

This option allows you to move the columns in the list view. If for example, you want the "Modified Date" to appear in the column before
"Size", simply click on the "Modified Date" and drag it to the front of the "Size" column, then release. Now, the "Modified Date" column is
positioned before the "Size" column. Your column positions are saved between sessions. This option is only supported in Details view.

Full Row Select
This option selects an entire row when any of the contents of the row is selected. Unlike normal operation, where you must click on the name to
select the row, this option allows you to click anywhere on the information for the file or folder. This option is only supported in Details view.



Connection Options

Ftp Access Type
The Internet Access Type allows you to choose how you want to access the Internet. The following are the options:

o Direct Internet Access (default) - access the Internet directly without going through a proxy server. Also, use this option to access internal
FTP sites, or if you access both the Internet and are required to go through a proxy, use the Advanced options for your site.

o CERN Proxy Access - use the proxy server specified.

o Pre-Config Access - Access FTP sites the same way as Microsoft Internet Explorer (3.0).

®  UserID = userid@site - use the proxy server specified, but when connecting to a site, use the proxy server for the site name and create a user
id "userid@site" for the user ID. For example, if connecting through a proxy server to Microsoft, the site used would be your proxy server
and the user ID, automatically generated by Net Probe, would be "anonymous@ftp.microsoft.com". In anonymous mode, the password
would be "NetProbe@www.rhinosoft.com". With this mode, you may also specify a password for the proxy server (if your proxy server
requires a password).

Ftp Proxy Name
If you're using a proxy server, enter your proxy server name here.

Ftp Port
Enter the port number of the proxy to connect to.

Ftp Proxy Password
If you select the "UserID = userid@site" Internet Access Type, you are allowed to enter a password for your proxy server. If you leave this field
blank, no password will be used.

The format used for the FTP site is <proxy name>:<proxy password>. Net Probe automatically does this operation for you.

Http Access Type
The Internet Access Type allows you to choose how you want to access the Internet. The following are the options:

o Direct Internet Access (default) - access the Internet directly without going through a proxy server. Also, use this option to access internal
HTTP sites.

o CERN Proxy Access - use the proxy server specified.

o Pre-Config Access - Access HTTP sites the same way as Microsoft Internet Explorer (3.0).

Http Proxy Name
If you're using a proxy server, enter your proxy server name here.

Http Port
Enter the port number of the proxy to connect to.

Http Proxy Password
This option is not supported for HTTP sites.

PASV Mode
Check this box to always use PASV mode when connecting to an FTP site.

Connection Time-out
The time-out value in seconds to use for Internet connection requests. If a connection request takes longer than this time-out, the request is
canceled. The default time-out is 61.

Connection Retries
The retry count to use for Internet connection requests. If a connection attempt still fails after the specified number of tries, the request is
canceled. The default is zero.

Send Time-out
The time-out value in seconds to use for data Internet send requests. If a data send request takes longer than this time-out, the request is canceled.
The default time-out is 61.

Receive Time-out
The time-out value in seconds to use for data Internet receive requests. If a data receive request takes longer than this time-out, the request is
canceled. The default time-out is 61.

Max Concurrent Threads
The maximum amout of sites that Net Probe will check simultaniously. If you are having problems with sites timing out, you may want to try
lowering this value. If you have a fast connection and speedy computer, you may want to experiment with higher values. The default is 10.



Beep when done checking
If this option is enabled, Net Probe will alert you when a checking operation has been completed.



Logging Options

This option allows you to automate the exporting of lists. If this option is enabled, Net Probe will export the current list to the directory
specified whenever the list is checked (either manually or through the scheduler), into a file corresponding to the time of the export.

Web
This option allows you to download the content of an entire list of sites. When the list is checked, any web sites will have their content stored in

the directory specified in a file corresponding to the address of the page.



File Menu

New
This command creates a new site list. If a site list is already open and has not been saved since last it was changed, you will be asked if you
would like to save the old list before creating a new one.

Open
Use this command to open a previously saved site list.

Save
To save the current site list, use this command.

Save As...
To save the current site list with a different name than is currently being used, use this command..

Import

To read sites in from text files, HTML files or FTP Voyager files use this command. Net Probe uses regular expressions to parse the text that is
imported, and can accommodate a variety of formats. The most common format that Net Probe can read is a URL, such as
http://www.rhinosoft.com:80/RhinoSoft/index.htm, while specifying login and password using l: login p: password.

Export
To write sites out to text files, HTML files or FTP Voyager files use this command.

Exit
Use this option to close or exit Net Probe.



Edit Menu

The Net Probe edit menu allows you to perform edit operations for Net Probe. The following are the commands supported in the Edit Menu:

Cut
If you have any sites selected, they will be copied into the clipboard in text format and deleted from the current site list. If you paste these sites
back into Net Probe, you will lose the site's status, description, and time last checked.

Copy
This command has the same effect as the Cut command, except that the selected sites are not deleted from the site list.

Paste
If there are any sites currently in the clipboard, they will be imported into the current site list as if you had used the Import command to import
them as text.

Edit Site
This button brings up the same dialog that was used to add a site and lets you edit a site's properties.

Select All
This option selects or highlights all of the sites and folders in the right hand pane. Use this option when you want to select all of the sites or you
want to select most of the sites.

Invert Selection
This option converts selected sites into deselected sites, and converts deselected sites into selected sites.



View Menu

The Net Probe view menu allows you to perform visual operations for Net Probe. The following are the commands supported in the View
Menu:

Toolbar
If selected, the toolbar is shown under the menu. This is selected by default.

Status Bar
If selected, the Status Bar is shown at the bottom of the window. This is selected by default.

Options
Use this command to view or change the options dialog box.



Tools Menu

The Net Probe tool menu gives you many miscellaneous functions. The following are the commands supported in the Tools Menu:

New Site
A dialog will appear which allows you to specify the site's name, description, and other properties. After completing the necessary information,
the site will be added to the list.

Delete Selected
The delete command allows you to remove sites from the site list.

Check All

This command allows you to check all sites on the list. ~Sites that have changed since last time they were checked (or sites that have never been
checked) will have a light bulb in their name field. Sites that have not changed, but which are up, will show a green check. Sites that are bad
will have a red X, and sites that have never been checked will have a question mark near them.

Check Selected
Check Selected is similar to Check All, but only the sites that are currently selected are checked.

Open Site
Open site allows you to launch your default web browser to the selected web site, or your preferred FTP client to the selected FTP site. You may
change your FTP client in the General Options.

FTP Search
This command brings up a dialog that allows you to search the Internet for a particular file.



Help Menu

The Net Probe help menu allows you to get help for Net Probe and allows you to order Net Probe from Rhino Software. The following are the
commands supported in the Help Menu:

Help Topics
This option allows you to search the help file for topics or information that is contained within the help file.

Overview
This option shows you an overview of the help file. From here you can select topics of interest and view documentation about your selection.

Purchase Net Probe Electronically
This option allows you to purchase Net Probe on-line. With this option you don't even need to pick up your telephone or visit a web page to
purchase your copy.

Ordering Information
This option gives you information about how Net Probe can be purchased and gives you pricing information for Net Probe, including quantity
discounts.

Register Net Probe

This option is used after Rhino Software sends you your registration ID. After you receive your registration ID you enter your name, e-mail
address, and your ID here. When you're registered you will not be annoyed by the initial "splash" dialog or the nag dialogs asking you to register
the product.

In addition you will be notified, via e-mail, of updates. And you will be able to receive e-mail support for up to one year after you purchase.
About Rhino Software Net Probe

Use this command to display the version number of Net Probe. If you are using a registered version of Net Probe, your name will appear in this
dialog box.



Pop-Up File or Folder Menu

Net Probe uses pop-up menus for common file operations. To access a pop-up menu for a file or folder, move the mouse pointer over the file or
folder and press the right mouse button. The following are the commands:

Open Site
Open site allows you to launch your default web browser to the selected web site, or your preferred FTP client to the selected FTP site. You may
change your FTP client in the General Options.

Edit Site
This button brings up the same dialog that was used to add a site and lets you edit a site's properties.

Delete Selected
The delete command allows you to remove sites from the site list.

Check Selected
Check Selected is similar to Check All, but only the sites that are currently selected are checked.

Cut
If you have any sites selected, they will be copied into the clipboard in text format and deleted from the current site list. If you paste these sites
back into Net Probe, you will lose the site's status, description, and time last checked.

Copy
This command has the same effect as the Cut command, except that the selected sites are not deleted from the site list.

Paste
If there are any sites currently in the clipboard, they will be imported into the current site list as if you had used the Import command to import
them as text.

Import
To read sites in from text files, HTML files or FTP Voyager files use this command.

New Site
A dialog will appear which allows you to specify the site's name, description, and other properties. After completing the necessary information,
the site will be added to the list.

Check All

This command allows you to check all sites on the list. ~Sites that have changed since last time they were checked (or sites that have never been
checked) will have a light bulb in their name field. Sites that have not changed, but which are up, will show a green check. Sites that are bad
will have a red X, and sites that have never been checked will have a question mark near them.

FTP Search
This command brings up a dialog that allows you to search the Internet for a particular file.



Using the List View

Net Probe allows you to change the order in which items are sorted in the site list. To change the sort order, click on the column you want to sort
by. Click the column button again to sort in the reverse direction. Click again to sort in the original direction.

If, for example, you want to sort files by file type, click on the Type column. If you want to sort by date, click on the Modified column.

Selecting a Single File
To select a single file, click on it.

Selecting Multiple Files
To select multiple files, click on one file, press and hold the control key while selecting another.

To select a sequence of files, click on one file, press and hold the shift key while selecting another file. All files between the first and second
files become selected.



Customize Toolbar

Opens the Customize Toolbar dialog box, where you can add, remove, and rearrange buttons on the toolbars. This command is available in the
View, Options, Toolbar, then by selecting "Buttons" or by double clicking on a "blank" area on the tool bar.

The toolbar contains a set of default buttons. You can remove buttons for commands that you rarely use, add other buttons for commands that
you frequently use, and specify the order in which the buttons appear on the toolbar.

To restore the default toolbar button settings, choose Reset in the Customize Toolbar dialog box.

Customize Toolbar Dialog Box Options

Available Buttons
Displays the buttons that you can add to the toolbar in the active window. Buttons that are already on the toolbar are not included in this list.

Add
Moves the selected button in the Available Buttons list to the Toolbar Buttons list and adds the button to the toolbar. The added button appears
above the currently selected button in the Toolbar Buttons list and to the left of the corresponding button on the toolbar.

Remove
Moves the selected button in the Toolbar Buttons list to the Available Buttons list and removes the button from the toolbar.

Toolbar Buttons
Displays the buttons from top to bottom in the order in which they appear from left to right on the toolbar in the active window.

Reset
Restores the default button settings on the toolbar in the active window.

Move Up
Moves the selected button up one space in the Toolbar Buttons list and to the left one space on the toolbar.

Move Down
Moves the selected button down one space in the Toolbar Buttons list and to the right one space on the toolbar.






